2009

Microsoft Word 2007 and Powerpoint 2007 Units for ELL Students in Introduction to Information Technology

Janel Jo LeMieux
Central Washington University

Follow this and additional works at: https://digitalcommons.cwu.edu/graduate_projects

Part of the Bilingual, Multilingual, and Multicultural Education Commons, and the Curriculum and Instruction Commons

Recommended Citation
https://digitalcommons.cwu.edu/graduate_projects/106
NOTE:

SIGNATURE PAGE OMITTED FOR SECURITY REASONS

THE REGULATIONS FOR SIGNATURE PAGES CAN BE FOUND ON CWU’S GRADUATE STUDIES WEBPAGE:

CWU.EDU/MASTERS/
MICROSOFT WORD 2007 AND POWERPOINT 2007 UNITS FOR ELL STUDENTS IN INTRODUCTION TO INFORMATION TECHNOLOGY

A Project Report
Presented to
The Graduate Faculty
Central Washington University

In Partial Fulfillment
of the Requirements for the Degree
Master of Education
Education Administration

by
Janel Jo LeMieux
August 5, 2009
ABSTRACT

MICROSOFT WORD 2007 AND POWERPOINT 2007 UNITS FOR ELL STUDENTS IN INTRODUCTION TO INFORMATION TECHNOLOGY

by

Janel Jo LeMieux

August 5, 2009

Trying to settle in a country whose language a person does not speak is challenging in itself. Attending a computer class when a person has never touched a computer is just another hurdle to overcome. The current curriculum is not conducive to English Language Learners in Introduction to Information Technology. Microsoft Word 2007 and Microsoft PowerPoint 2007 are two of the most widely used computer programs in the school. For this reason more effective curriculum was created for ELL students enrolled in the Introduction to Information Technology class.
TABLE OF CONTENTS

Chapter | Page
---|---
I INTRODUCTION | 1
  Background of the Project | 1
  Statement of the Problem | 1
  Purpose of the Project | 2
  Significance of the Project | 2
  Limitations of the Project | 3
  Definition of Terms | 4
II LITERATURE REVIEW | 8
  Instructional Methods | 12
    Computer Instruction Methods | 17
    Conclusion | 18
III PROCEDURES | 20
  Introduction | 20
  Personal Experience | 20
  Development of the Project | 21
  Procedures | 21
IV THE PROJECT | 24
  Microsoft Word 2007 | 25
  Microsoft PowerPoint 2007 | 129
V SUMMARY, CONCLUSIONS, AND RECOMMENDATIONS | 326
  Summary | 326
  Conclusions | 326
  Recommendations | 327
REFERENCES | 329
CHAPTER I

INTRODUCTION

Background of the Project

An English Language Learner (ELL) is "a student whose first language is other than English and who is in a special program for learning English (which may be bilingual education or English as a second language)" (Lexicon of Learning, 2008). It is widely known that ELL students in the United States face unique challenges to reach academic success. Not only do ELL students struggle to understand cultural differences, they can be delayed by their lower-level English language skills (Papai, 2000). With that being known, the number of ELL students enrolled in United States public education has grown significantly over the years. The percentage change from the 1994-1995 school year to the 2004-2005 school year was 56.2% (Numbers & Statistics Resources, 2006). This means there are more struggling ELL students in the United States than ever before.

Technology is one of the resources that will forever be growing and is a necessity to have some understanding and usage level if a person wants to progress in his/her career. Technology can be a challenge to many people, but especially to ELL students who have a difficult time with English, much less, technology vocabulary. It is easy for ELL students to become lost in the instructional part of a lesson while other students move fluently with the teacher directions (Schools, 1999).

Statement of the Problem

Think of the word "mouse." To an ELL student that simply means a small rodent; yet, in technology it is something completely different. Vocabulary development is an
issue when teaching ELL students technology. In addition, teachers know that
demonstrating and then having students follow along is an effective practice. However, it
is difficult for ELL students to follow along and they become lost and frustrated very
quickly (Robertson, 2008).

Most of the computer tutorials and textbooks are too wordy and complicated for
ELL students. These students need basic computer skills to complete assignments in
other classes (Visilearn' Research Study, 2003). Introduction to Information Technology
(IIT) is the perfect class for the students to learn the common computer programs of
Microsoft Word 2007 and PowerPoint 2007, yet the IIT curriculum is not effective for
ELL students to learn all that they can.

Purpose of the Project

The purpose of the this project is to create Microsoft Word 2007 and Microsoft
PowerPoint 2007 units for ELL students enrolled in Introduction to Information
Technology. This curriculum will be implemented at Lindbergh High School in the
Renton School District in grades 9-12. The use of the Internet will be incorporated
throughout these units as research shows the use of the Internet is an integral part to the
success of an ELL students' educational experience (Schools, 1999).

Significance of the Project

Currently, in the Renton School District, ELL students who are enrolled in the
beginning computer class are set up with a typing tutorial and learn to type for the entire
semester. While it is a way for ELL students to learn letters and how to type, they could
be learning much more if given relevant and rigorous curriculum geared towards English
language learners.
In addition, programs learned in the beginning computer class can be utilized in other disciplines. The Renton School District piloted a small learning communities program and even though it does not exist anymore, teachers still practice the theory of implementing themes across disciplines so students are able to apply what is learned in each class. A repetitive approach helps students learn the content more effectively (Small Learning Communities, 2002).

Students in the Renton School District are required to complete a culminating project in order to graduate. The ELL curriculum developed in the beginning computer class will provide ELL students with the foundation needed to complete the technological element of the culminating project. ELL students are already known to be performing below standards and have excessive dropout rates (The Nation's Report Card: 2005 Reading and Mathematics, 2005). The culminating project is another hurdle for ELL students to jump over so it is imperative they receive enough instruction to complete this project. The IIT class is essential for this piece.

Limitations of the Project

Most ELL students do not have computers or Microsoft programs at home so cannot practice at home what is learned at school (Robertson, 2008). In addition, just like non-ELL students, ELL students are all at different cognitive and noncognitive levels depending on how long they have been in the country and the educational level they received in their native country (Reigle, 2007). Teachers will have to identify the ability of each ELL student and determine if the ELL student can use the regular curriculum used by non-ELL students or the ELL curriculum created.
Definition of Terms

The following are terms with definitions that will help the reader comprehend the educational jargon used throughout this paper:

*Career and Technical Education (Vocational Education):* “A planned program of courses and learning experiences that begins with exploration of career options, supports basic academic and life skills, and enables achievement of high academic standards, leadership, preparation for industry-defined work, and advanced and continuing education” (Career and Technical Education).

*Constructivism:* “An approach to teaching based on research about how people learn. Many researchers say that each individual "constructs" knowledge rather than receiving it from others. People disagree about how to achieve constructive learning, but many educators believe that students come to understand abstract concepts best through exploration, reasoning, and discussion” (Lexicon of Learning, 2008).

*Culminating (senior) project:* “A graduation requirement in which each student will demonstrate essential skills through reading, writing, speaking, production and/or performance. To complete the project, students may be asked to write a research paper, work with a mentor in school or in the community, present to a community or peer panel, pull together a portfolio of work and/or develop a multi-media presentation” (Graduation Requirements).

*Curriculum:* “a written plan outlining what students will be taught (a course of study). Curriculum documents often also include detailed directions or suggestions for teaching the content. Curriculum may refer to all the courses offered at a given school, or all the courses offered at a school in a particular area of study. For example, the English
curriculum might include English literature, literature, world literature, essay styles, creative writing, business writing, Shakespeare, modern poetry, and the novel. The curriculum of an elementary school usually includes language arts, mathematics, science, social studies, and other subjects” (Lexicon of Learning, 2008).

Differentiated curriculum: “A form of instruction that seeks to "maximize each student's growth by meeting each student where she is and helping the student to progress. In practice, it involves offering several different learning experiences in response to students' varied needs. Learning activities and materials may be varied by difficulty to challenge students at different readiness levels, by topic in response to students' interests, and by students' preferred ways of learning or expressing themselves” (Lexicon of Learning, 2008).

English Language Learner: “A student whose first language is other than English and who is in a special program for learning English (which may be bilingual education or English as a second language)” (Lexicon of Learning, 2008).

Introduction to Information Technology: “This is the first course in the Information Technology sequence of coursework. In this course the student will learn: The keyboard, 10-key pad and correct technique; Basic formatting of business documents and reports; and, Basic features of Word (word processing software), Access (database software), PowerPoint (presentation software) and Excel (spreadsheet software)” (Pathways, 1999-2006)

MS PowerPoint 2007: “Enables users to quickly create high-impact, dynamic presentations, while integrating workflow and ways to easily share information” (Microsoft Office PowerPoint 2007 Product Overview, 2008).
**MS Word 2007:** “A powerful authoring program that gives you the ability to create and share documents by combining a comprehensive set of writing tools with the easy-to-use Microsoft Office Fluent user interface” (Microsoft Office Word 2007 Product Overview, 2008).

**Pedagogy:** “The art of teaching—especially the conscious use of particular instructional methods. If a teacher uses a discovery approach rather than direct instruction, for example, she is using a different pedagogy” (Lexicon of Learning, 2008).

**Performance based assessment:** “A form of assessment that is designed to assess what students know through their ability to perform certain tasks. For example, a performance assessment might require a student to serve a volleyball, solve a particular type of mathematics problem, or write a short business letter to inquire about a product as a way of demonstrating that they have acquired new knowledge and skills. Advocates believe such assessments—sometimes called performance-based assessments—provide a more accurate indication of what students can do than traditional assessments, which might require a student to fill in the blank, indicate whether a statement is true or false, or select a right answer from multiple given choices. Evaluating students through task performance can be more time-consuming and therefore more expensive. Most large-scale assessments (such as state testing programs) use this form of assessment sparingly, if at all. But many educators believe it is worth the extra cost because it provides a more accurate and realistic picture of student learning” (Lexicon of Learning, 2008).

**Project based assignment (method):** “Teaching by engaging students in a long-term activity in which they gather information and develop a product of some kind, such as a written report, oral presentation, or model. Some educators believe that students learn
more, understand the content more thoroughly, and remember information and skills longer when they work on a project” (Lexicon of Learning, 2008).
CHAPTER II

LITERATURE REVIEW

In 1963, President John F. Kennedy stated, “Simple justice requires that public funds, to which all taxpayers of all races [colors, and national origins] contribute, not be spent in any fashion which encourages, entrenches, subsidizes or results in racial [color or national origin] discrimination” (Title VI of the Civil Rights Act of 1964, 2003).

Thus, Title VI of the Civil Rights Act of 1964 was founded. This act prohibits discrimination on the basis of race, color, and national origin in programs and activities receiving federal financial assistance (Title VI of the Civil Rights Act of 1964, 2003). This, of course, included public education to all.

Nonetheless, compliance with this Act was not easy for some. This was best described in the Lau v. Nichols case in 1974. A San Francisco school was accused of discriminating against Chinese American ELL students by not providing appropriate accommodations for their limited English proficiency. The United State Supreme Court ruled in favor of the students saying the school district was not offering these students equal educational opportunities on the basis of their ethnicity (Lau v. Nichols, 1974). This was a landmark case for ELL students and their right to receive proper education.

Now, with the implementation of No Child Left Behind (NCLB) 2001, educators are being held even more accountable for the success of all students. This means all students, including ELL students, must meet the academic standards outlined by the state. There are accommodations outlined to help ELL students during the high stakes testing (No Child Left Behind). Now, more than ever, is a time when educators need to step up and use instructional strategies so that ELL students can meet the criteria outlined by
NCLB. With over 5 million ELL students enrolled in grades Pre K-12, it is essential we reach out to them (Numbers & Statistics Resources, 2006).

In Washington State the ELL population has also grown significantly. The percentage change from the 1994-1995 school year to the 2004-2005 school year was 46.7%. Washington State now has approximately 76,000 ELL students enrolled in schools (Numbers & Statistics Resources, 2006). How are these students doing in relation to NCLB? On the 10th grade 2006-2007 Washington Assessment of Student Learning (WASL) only 38.3% passed the reading section, 10.7% passed the math section, 37.7% passed the writing section, and 2.9% passed the science section. In comparison, the state average meeting standard was 80.8% in reading, 50.4% in math, 83.9% in writing, and 36.4% in science (Washington State Report Card).

In the Renton School District, the ELL population has steadily increased every year. The current ELL enrollment for the 2007-2008 school years shows nearly 2,000 ELL students in the district (RSD ESL Enrollment, 2008). With these increases and the probability that the number of ELL students will continue to grow, teachers in the district need to be prepared to teach these students. One of those methods is with the use of technology.

Technology has been around for years. When looking at a timeline various forms of technology were used as early as in the 1940’s. It is evident the computer age truly took off in the late 1980’s and entered into most all schools in the early 1990’s. The most significant usage of technology is the convenience of the Internet which is wired in all schools around the United States (History of Computers in Education, 2007).
Educators realize that technology plays an important part in students' education and that it can provide a useful component to ELL pedagogy. The availability of technology has risen and usage in the classroom has as well. With that, researchers have found many advantages of and a few disadvantages of using technology with ELL students (Schools, 1999).

Research suggests many benefits of using technology in classrooms with ELL students which include the following mentioned by Lee (2000) and Warschauer & Healey (1998):

- Experiential learning – the students choose what they learn by exploring and doing it themselves.
- Motivation – Most students love computers because they are known to be fun and enjoyable. Allowing students to use the computer increases motivation and creates a sense of independence.
- Enhanced Student Achievement – Network-based instruction can help pupils strengthen their linguistic skills by positively affecting their learning attitude and by helping them build self-instruction strategies and promote their self-confidence.
- Authentic Materials for Study – Students may access resources any time of day from multiple locations other than school.
- Great Interaction – Random access to Web pages breaks the linear flow of instruction. There are various ways to communicate with other people on the Internet.
• Individualization – Student personalities vary from very reserved to a high level of loud ambition. The computer allows students to work at his/her own pace.

• Independence from a single source of information – “Although students can still use their books, they are given the chance to escape from canned knowledge and discover thousands of information sources. As a result, their education fulfills the need for interdisciplinary learning in a multicultural world” (Warschauer & Healey, 1998).

There are some disadvantages of technology assisting ELL students. One of the most common concerns is the financial burden it puts on the school district and possibly the ELL family who may be in a low socio-economic status. With this in mind, teachers may have to differentiate technology instruction (Robertson, 2008). In addition, technology changes at a relatively fast pace that it is difficult to keep up with the advancements. This can be a frustration to the teacher and to the student who has just learned the program and then it is updated (Lee, 2000). Lastly, ELL students need to have some basic technology knowledge before they apply computer technology to assist second language teaching and learning (Lai & Kritsonis, 2006). Fortunately, the IIT class in the Renton School District would allow ELL students to become familiar with computers; and, if properly taught, ELL students would be able to utilize the computer in other classes to advance their second language learning.
Instructional Methods

_Sheltered Instruction Observation Protocol_

Research was conducted for a decade before the concept of Sheltered Instruction Observation Protocol (SIOP) was invented. After its implementation, research has proven that English learners who have teachers trained and are consistently using the SIOP model perform significantly higher than students who do not have teachers trained in the SIOP model. What is SIOP? SIOP is a scientifically validated model of sheltered instruction designed to make grade-level academic content understandable for English learners while at the same time developing their English language. The protocol and lesson planning guide ensure that teachers are consistently implementing practices known to be effective for English learners (S.I.O.P Equity Academy, 2007).

This teaching strategy allows ELL students to perform and succeed academically in content classes needed to graduate. As fearful as teachers are of having to completely reconstruct what they already have created, this model does not require teachers to toss out their lessons, but provides a different approach on how to teach what they always have taught. It is important to note that SIOP can be used as an instructional model and an observation protocol. It is beneficial for both teachers and administrators to be trained in this method (Echevarria & Short, 2008).

As Echevarria & Short point out, the protocol is composed of 30 items grouped into 3 sections:

1. Preparation – examines the lesson planning process, including the language and content objectives, the use of supplementary materials, and the meaningfulness of the activities.
2. Instruction – subdivided into six smaller categories which are building background, comprehensible input, strategies, interaction, practice/application, and lesson delivery. Within these categories emphasis is put on instructional practices that are critical for ELL students such as making connections with students’ background experiences and prior learning, adjusting teacher speech, emphasizing vocabulary development, using multimodal techniques, promoting higher order thinking skills, grouping students appropriately for language and content development, and providing hands-on materials.

3. Review/assessment – four items consider whether the teacher reviewed the key vocabulary and content concepts, assessed student learning, and provided feedback to students on their output.

_Understanding by Design (UBD)_

As Stephen Covey states, “To begin with the end in mind means to start with a clear understanding of your destination. It means to know where you’re going so that you better understand where you are now so that the steps you take are always in the right direction” (Covey, 1989). This statement represents the concept of the Understanding by Design (UBD) framework. UBD focuses on effective design of curriculum, instruction, and assessment so that students know what they are asked to learn and actually retain what is learned (Wiggins & McTighe, 2005).

Wiggins and McTighe (2005) indicate that UBD identifies three stages of backward design:
1. Identify desired results – What should students know, understand, and be able to do? What content is worthy of understanding? What enduring understandings are desired? This stage, essentially, is when the teacher narrows down and recognizes the goal(s).

2. Determine acceptable evidence – How will the teacher know if students have achieved the desired results? What will the teacher accept as evidence of student understanding and proficiency? Do not simply create ineffective lessons just so students have something to do. Teachers need to first “think like an assessor” before designing lessons so that they know how they will determine if students have learned what is being taught.

3. Plan learning experiences and instruction – Now that the teacher has identified goal(s) and established the evidence needed to prove understanding, it is time to develop the most suitable instructional activities. Teachers need to ask themselves, what enabling knowledge (facts, concepts, principles) and skills (processes, procedures, strategies) will students need in order to perform effectively and achieve desired results? What activities will equip students with the needed knowledge and skills? What will need to be taught and coached, and how should it best be taught, in light of performance goals? What materials and resources are best suited to accomplish these goals?

*Universal Design for Learning (UDL)*

The Universal Design for Learning (UDL) was developed by a widely known research group called the Center for Applied Special Technology (CAST). UDL includes
Universally Designed Instruction (UDI) as well as the concept of Universally Designed Curriculum (UDC) and Universal Design in Assessment (UDA) (Universal Design for Learning: Reaching all, Teaching Al, 2004). In the research CAST (2007) conducted they identified three primary brain networks and the roles they play in learning:

- **Recognition networks** – how students identify and categorize what they see, hear, and read. Providing alternative representation of content can increase learning opportunities.

- **Strategic networks** – how students organize and express their ideas. Providing multiple options for expression and control will help add to the accessibility of learning to all students.

- **Affective networks** – how students are challenged, excited, or interested. Providing options that promote engagement, interest and motivation will help achieve optimal learning.

CAST (2007) points out that UDL takes the concept of differentiated instruction and individualizes it. A universally-designed curriculum offers the following:

- **Multiple means of representation** to give learners various ways of acquiring information and knowledge

- **Multiple means of action and expression** to provide learners alternatives for demonstrating what they know

- **Multiple means of engagement** to tap into learners’ interests, challenge them appropriately, and motivate them to learn
What does this all mean? Dr. Burgstahler, a member of the DO-IT (Disabilities, Opportunities, Internetworking, and Technology) organization at the University of Washington suggests the best way to apply the UDL approach (Universal Design of Instruction (UDI): Definition, Principles, and Examples, 2008):

- **Class Climate** – Welcome everyone, avoid stereotyping, be approachable and available, motivate all students, and address individual needs in an inclusive manner.

- **Interaction** – Promote effective communication, make interaction accessible to all participants, and encourage cooperative learning.

- **Physical Environments and Products** – Ensure physical access to facilities, arrange instructional spaces to maximize inclusion and comfort, ensure that everyone can use equipment and materials, and ensure safety.

- **Delivery Methods** – Select flexible curriculum, make content relevant, provide cognitive supports, provide multiple ways to gain knowledge, deliver instruction clearly and in multiple ways, make each teaching method accessible to all students and use large visual and tactile aids.

- **Information Resources and Technology** – Select materials early, use multiple, redundant presentations of content that use multiple sense, accommodate a variety of reading levels and language skills, when appropriate, given the goals of the course, ensure the availability of appropriate assistive technology.

- **Feedback** – provide regular feedback and corrective opportunities.
• Assessment – set clear expectations, provide multiple ways to demonstrate knowledge, monitor and adjust, test in the same manner in which you teach, minimize time constraints when appropriate.

• Accommodation – know how to arrange for accommodations.

*Computer Instruction Methods*

Visilearn (2003) conduct research that was both qualitative and quantitative in the more specific area of technology instruction. From its findings, the following techniques and methods were found most effective when teaching ELL students:

• Hands-on labs
• Simple, step-by-step instructions
• Lots of large graphics
• Information presented in small chunks
• Real-world exercises

Visilearn (2003) indicated that the teachers in the study said that class materials should be organized and presented in the following way:

• Tasks: Computer tutorials should be organized by tasks: the things most students want to do with the program.

• Steps: For each task, list concise, step-by-step instructions.

• Illustration: Illustrate each step with a computer screen shot that shows exactly what to do. The bigger the better.
• Reinforcement: At the end of each important task, include stand-alone exercises so students can practice the tasks. Include multiple exercises so students who work quickly remain occupied.

Additional tips included clear page numbering, a spot color, and spiral bound book so the book lays flat on the desk (Visilearn' Research Study, 2003).

Many English learners may not be comfortable with computers yet. To enhance the learners experience with computers and ease the fears of some students, Beare (1999) recommended the following can be done:

• Always check that the computer is on and the monitor is showing the correct image. If the teacher does not realize the computer is not on and starts teaching, this will create panic for the ESL student.

• If the student is extremely apprehensive of the computer, place that student next to a student who is very comfortable with computers and is open to helping other students. When the student helps the English learner, make sure the English learner uses the mouse and keyboard.

• Start easy and then increase computer activity. At the beginning, do not assign a difficult activity on the computer. Slowly transition into more complex assignments as the student becomes more comfortable with the computer.

Conclusion

In conclusion, once educators understand the pedagogical theories and research proven strategies surrounding the education of English Language Learners, there will be
an increase in test scores and in the value of education for this population: It can be done. Use of these strategies from the research in this study will provide a foundation in the creation of basic technology skills curriculum for ELL students to use in multiple classes and the senior culminating project for the district.
CHAPTER III

PROCEDURES

Introduction

The purpose of this project is to design curriculum which will aid English Language Learners develop their computer skills. Specific computer programs will be emphasized. Microsoft Word 2007 and Microsoft PowerPoint 2007 are the most frequently used computer programs in schools and will, therefore, be highlighted. The skills learned in the units will be fairly basic but are the most helpful techniques needed for success in computer usage.

Personal Experience

The author is a high school (9-12) business education teacher concluding a sixth year in education that has been completed at two distinctively different high schools. The author’s first place of employment was in a district with two predominant ethnicities: Hispanic and Caucasian. At this school a specific course called Sheltered Keyboarding for Spanish speaking students was taught by the author. A paraeducator was provided and, fortunately, vague Spanish language skills were beneficial. With all students being at relatively the same skill level it was somewhat easier to teach to all students without many individual modifications. If a student was clearly comfortable with technology and language skills were advanced, general education work was given.

The author’s second and current place of employment provided a cultural shock. The diversity in the school is massively different than at the first school. The minority populations are the majority with nearly eighty foreign languages being spoken. Vague Spanish language skills are not of use in this district. There is not a specific computer
course for a certain language because no one language is predominant. The implementation of previous “sheltered” assignments are of no usefulness as the directions are in Spanish and are intended for Spanish speaking direct instruction and demonstration. Currently, ELL students are enrolled in the Introduction to Information Technology (IIT) class required during a student’s ninth grade year. Typically 2-5 ELL students are enrolled per class between the twelve sections taught during the year.

Development of the Project

After observing the difficulties ELL students encountered, the author was certain better curriculum could be developed for this struggling population. Therefore, beginning in the Summer of 2008, extensive research was conducted including historical information related to the English Language Learners, pedagogical practices, computer integration, and software resources. A multitude of sources were used to complete this research including the Education Resources Information Center (ERIC), ProQuest databases, educational and governmental Websites, books, and educational workshop manuals. In addition, computer software is needed to develop this curriculum. The author used personal experience and the advice of professionals to decide on the best program.

Procedures

When the research was completed, the author chose the best research data-driven pedagogical strategies for not only ELL students, but all students. Many steps needed to be done to create the most effective curriculum. These included: 1) gaining support from administration; 2) approval from advisory committee; 3) receiving support and feedback
from colleagues; 4) creating lesson plans aligned with instructional strategies; 5) issuing a trial implementation; and 6) project finalization.

The first step is more of a professional courtesy and an annual evaluation necessity. A day was set for the author to present to the school administration the project being developed. Afterwards, the administration provided the author with suggestions on rigorous and relevant literature to be used in the author's research and full support was shown. Since the author is a Career and Technical Education (CTE) instructor, the author informed the district CTE director of the project. The CTE director offered professional support whenever the author needed it and asked that the author's professional development activity (the project) be approved by the CTE advisory committee.

Step two was completed when the Business Education staff met with the CTE advisory committee comprised of community members in the business field. After the author presented the project, the advisory committee gave written approval of the professional development activities.

In addition, the other business educators were excited and offered much support and advice to the author. This led to step three of the project—receiving support and feedback from colleagues. The author arranged a meeting with business teachers from the district and ELL teachers from the school. The CTE staff in the district has experienced the same frustrations as the author when it came to ELL students learning the curriculum in the IIT class. The author took notes on these irritations, which were essentially unanimous, and discussed possible resolutions with the ELL instructors. The business educators and the ELL educators of the district departed the meeting optimistic of the author's project.
The author looked forward to step four: creating lesson plans aligned with instructional strategies. After all the research conducted and the personal experiences relayed, the first draft of the curriculum was developed using the pedagogical theories of Understanding by Design, Sheltered Instruction Observation Protocol, Universal Design for Learning, and the Visilearn research for computer instruction. Additionally, the author created performance-based assessments and some assignments were project based. The computer software, SnagIt, was utilized for the visual aspects of the curriculum so only relevant locations of the computer screen were displayed.

Step five occurred after the creation of the curriculum when the author dispersed a rough draft of the curriculum to other business educators in the district for a trial run. Of course the author used the curriculum in the school’s IIT classes as well. After the first unit was tested, the author met with the business teachers and reviewed pros and cons of the curriculum.

After the debriefing, the last step included a printed revision and finalization of the curriculum. The curriculum was then handed out to other business educators in the district for use in all IIT classrooms.
CHAPTER IV
THE PROJECT

The following includes introductory units for Microsoft Word 2007 and PowerPoint 2007. The graphical step-by-step assignments and multilevel assessments comprised for each unit includes the following:

1. Microsoft Word 2007: Creating a Flyer
2. International Club Flyer
3. Play Auditions Flyer
4. Soccer Camp Flyer
5. Flyer Labeling Test
6. Renton River Days Assessment
7. Microsoft PowerPoint 2007: Creating a Presentation
8. Internet Safety Presentation
9. School Success Presentation
10. Dress for Success Presentation
11. PowerPoint Labeling Test
12. PowerPoint Test
13. Dream Vacation Project Assessment
Microsoft Word
Chapter 1
Creating a Flyer

Learning Objectives:

You will have mastered the tasks in this chapter when you can perform the following:

- Open Word
- Save a New Document
- Save to Current Location
- Enter Text
- Insert Clip Art
- Format Picture
- Insert Bullets
- Page Border
- Format text
  - Heading 1 Styles
  - Heading 2 Styles
  - Bold
  - Italics
  - Underline
  - Font Size
  - Font Style
  - Center

Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

IF YOU NEED ANY HELP JUST ASK!
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the Microsoft Word Flyer.

Learning Objective:
The student will be able to open and save as a word document.

- Open Word

- Click the "Office Button"

- Hover over "Save As"

- Click "Word Document"
• Navigate to your “W: Drive”

1. Click the “My Documents” drop down arrow

2. Click the W: drive (the one with your login name)

• Click the New Folder button
1. Type: Word Chapter 1
2. Click "OK"

1. Type: Microsoft Word Flyer
2. Click "Save"
Learning Objective:
The student will be able to enter text on a Word document.

- Type the headline:
  Microsoft Word

- Press the ENTER key on your keyboard to move to the next line.
Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

Press the **ENTER** (2) times on your keyboard to move to the next line.
Learning Objective:
The student will be able to **save** to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:
The student will be able to insert **Clip Art**.

- Click the "Insert" tab on the ribbon.

- Click "Clip Art".

---
Type: **Flyer** in the “**Search for:**” box

2. **Click** “Go”

You can create many different types of documents in a word processing program. You will learn in this assignment is a flyer. A flyer is usually used for something. There are some very specific parts of a flyer and they are listed.

- **Click** the clip art shown or a similar clip art picture if the circled one is not available.
Learning Objective:

The student will be able to insert **Bullets**

- **Click below the picture**

---

**Microsoft Word**

Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

---

**Insertion point moved below picture**

---

- **Click the **Bullets** button** on the Home tab.
Microsoft Word

Microsoft Word is a word processing program. You can create many different types of documents using this program. The type of document you will learn in this assignment is a typical advertisement designed to advertise something. There are some very specific parts of a Microsoft Word document that you will need to know:

- **BIG heading**
- **Detailed information**
- **Catchy picture**
- Sometimes a border

If you need any help just ask!

---

**Click the Bullets button again to get rid of the last bullet**

---

**Type:**

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

If you need any help just ask!
Learning Objective:
The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:
The student will be able to format **Heading 1** by changing **style set, color, and font**.

- Highlight the title "Microsoft Word".

Microsoft Word is a word processing program. You can use this program. The type of document you will learn in this program. There are some sample documents below.
Microsoft Word

Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer, produced to advertise something. There are some very specific parts of a flyer below.

1. Click "Change Styles"

2. Click "Style Set"

3. Click "Modern"
Microsoft Word is a word processing program. You can create many different types of documents. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

If you need any help just ask!
Learning Objective:

The student will be able to **save** to current location.

- Click the quick "Save" button to save what you have done so far.
Learning Objective:

The student will be able to **Center**

The student will be able to change **Font Size**

The student will be able to change **Font Style**

---

1. Click the "Center" button

2. With the text still highlighted

   1. Click the **Font Size** box arrow

   2. Click "36"
Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

If you need any help just ask!
Learning Objective:

The student will be able to apply **Bold**

The student will be able to **Underline**

The student will be able to apply **Italics**

- Highlight

“*word processing program*”

Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

If you need any help just ask!
Microsoft Word is a word processing program. You will learn in this assignment is a flyer. A flyer is usually used to advertise something. There are some very specific needs for a flyer.
Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

learning objective:

The student will be able to change Font Size

highlight the bulleted list
Learning Objective:

The student will be able to save to current location

- Click the quick "Save" button to save what you have done so far.
Learning Objective:

The student will be able to format **Heading 2**

The student will be able to **Center**

The student will be able to change **Font Size**

- Highlight the last line (signature line)

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

- If you need any help just ask!

- Click **"Heading 2"**

Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a *flyer*. A flyer is usually produced to advertise something. There are some very specific parts of a flyer as
Microsoft Word is a word processing program. You can create different types of documents in this program. The type of document we will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer, which are listed below.

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

IF YOU NEED ANY HELP JUST ASK!
This is how it should look

• BIG Heading
• Detailed Information
• Catchy Picture
• Sometimes a border

IF YOU NEED ANY HELP JUST ASK!

Learning Objective:

The student will be able to Center and resize an image

1. Click the image
2. Click the "Center" button

Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

• BIG heading
• Detailed information
• Catchy picture
• Sometimes a border

IF YOU NEED ANY HELP JUST ASK!
Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

If you need any help just ask!
This is how it should look.

Everything is on one page.

Learning Objective:
The student will be able to choose a picture style for an image.
Microsoft Word is a word processing program. You can create different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually used to advertise something. There are some very specific parts of a flyer, and they are listed below.

Click the last picture style

"Compound Frame, Black"
Learning Objective:

The student will be able to **save** to current location.

- **Click** the quick “**Save**” button to save what you have done so far.
Learning Objective:
The student will be able to insert a page border.

1. Click "Page Layout"
2. Click the "Page Borders" button

1. Click the "Art:" box arrow
2. Click the paperclip picture
1. Click the "Color:" box arrow

2. Click the color "blue"

- Click "OK"
Microsoft Word is a word processing program. You can create many different types of documents in this program. The type of document you will learn in this assignment is a flyer. A flyer is usually produced to advertise something. There are some very specific parts of a flyer and they are listed below.

- BIG heading
- Detailed information
- Catchy picture
- Sometimes a border

IF YOU NEED ANY HELP JUST ASK!

• Click the quick "Save" button to save one last time.
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

- Every first Monday
- Room 250b
- 2:15-3:00pm

COME CELEBRATE OUR CULTURES!
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the Microsoft Word Flyer

Learning Objective:

The student will be able to open and save as a word document

- **Open Word**

- **Click the "Office Button"**

- **Hover over "Save As"**

- **Click "Word Document"**
Navigate to your “W: Drive”

1. Click the “My Documents” drop down arrow

2. Click the W: drive (the one with your login name)

Click the folder “Word Chapter 1”

Click “Open”
Learning Objective:

The student will be able to enter text on a Word document.

- Type the headline:
  
  International Club
International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.
Press the **ENTER (2)** times on your keyboard to move to the next line

---

International Club

International Club celebrates the many different cultures and promotes cultural awareness through various activities such as watching movies, and celebrating various holidays, like New Year.

---

**Learning Objective:**

The student will be able to **save** to current location

---

**Click** the quick "**Save**" button to save what you have done so far.
Learning Objective:

The student will be able to insert Clip Art

- Click the "Insert" tab on the ribbon

- Click "Clip Art"

1. Type: Culture in the "Search for:" box

2. Click "Go"
Learning Objective:
The student will be able to insert Bullets

- Click below the picture

International Club

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.
Click the Bullets button on the Home tab.

- Type:
  - Every first Monday
  - Room 250D
  - 2:15-3:00pm

Click the Bullets button again to get rid of the last bullet.
International Club

International Club celebrates the many different cultures by promoting cultural awareness through various activities, such as watching movies, and celebrating various holidays like the New Year.

- Every first Monday
- Room 250D
- 2:15-3:00pm

Come celebrate our cultures!
Learning Objective:

The student will be able to format by changing **style set, color, and**

The student will be able to change **style set, color, and**

- Highlight the title

“International Club”

International Club celebrates the many different cultures around the world and promotes cultural awareness through various activities. Past activities include watching movies, and celebrating various holidays, such as the New Year.

- Click the “**Heading 1**” style in the styles gallery
International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

Every first Monday
Room 250D
2:15-3:00pm

Come celebrate our cultures!
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.
Learning Objective:
The student will be able to **save** to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:
The student will be able to change **Font Size**.

The student will be able to change **Font Style**.

With the text still highlighted:

1. Click the **Font Size** box arrow
2. Click "36"

---

International Club celebrates the many different cultures around the world. It promotes cultural awareness through various activities. Past activities include watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and New Year.
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

Every first Monday
Room 2500
2:15-3:00 p.m

Come celebrate our cultures!

1. Click the Font Size box arrow
2. Click “14”
Learning Objective:

The student will be able to **Underline** `U`.

The student will be able to apply **Italics** `I`.
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.
Learning Objective:

The student will be able to change **Font Size**

The student will be able to change **Font Style**

The student will be able to apply **Bold**

- Highlight the bulleted list

movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

- Every first Monday
- Room 250D
- 2:15-3:00pm

Come celebrate our cultures!

1. Click the **Font Size** box arrow
2. Click "14"
Learning Objective:

The student will be able to **save** to current location.

- Click the quick "**Save**" button to save what you have done so far.
**Learning Objective:**

The student will be able to format **Heading 2**

The student will be able to change **Font Size**
Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

- Every first Monday
- Room 250D
- 2:15-3:00pm

Come celebrate our cultures!
Learning Objective:

The student will be able to Center and resize an image.

INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

- Every first Monday
- Room 250D
- 2:15-3:00pm

COME CELEBRATE OUR CULTURES!
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

- Every first Monday
- Room 250D
- 2:15-3:00pm

COME CELEBRATE OUR CULTURES!
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

- Every first Monday
- Room 250D
- 2:15-3:00pm

COME CELEBRATE OUR CULTURES!

Learning Objective:

The student will be able to choose a picture style for an image
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

INTERNATIONAL CLUB
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

• Every first Monday
• Room 250D
• 2:15-3:00pm

COME CELEBRATE OUR CULTURES!
Learning Objective:
The student will be able to save to current location

- Click the quick "Save" button to save what you have done so far.

Learning Objective:
The student will be able to insert a page border

1. Click the "Page Layout" button
2. Click the "Page Borders" button
1. Click the "Art:" box arrow.

2. Click the globe picture.

- Click "OK"
INTERNATIONAL CLUB

International Club celebrates the many different cultures around the world. International Club promotes cultural awareness through various activities. Past activities have included eating, dancing, watching movies, and celebrating various holidays, such as Mardi Gras, Cinco de Mayo, and Chinese New Year.

- Every first Monday
- Room 250B
- 2:15-3:00pm

COME CELEBRATE OUR CULTURES!

• Click the quick "Save" button to save one last time.
Play Auditions

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

- Friday, March 9
- 5:00pm
- Carco Theatre

You can be a star!
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the Microsoft Word Flyer.

Learning Objective:
The student will be able to open and save as a word document.

- Open Word

- Click the "Office Button"

- Hover over "Save As"

- Click "Word Document"
Navigate to your “W: Drive”

1. Click the “My Documents” drop down arrow

2. Click the W: drive (the one with your login name)

1. Click the folder “Word Chapter 1”

2. Click “Open”
Learning Objective:

The student will be able to enter text on a Word document.

1. Type the headline:

   Play Auditions

2. Press the ENTER key on your keyboard to move to the next line.
Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

Learning Objective:

The student will be able to insert **Clip Art**

1. Click the "**Insert**" tab on the ribbon
2. Click "**Clip Art**"
1. Type: **Theater** in the “Search for:” box.

2. **Click** “Go”.

3. **Click** the clip art shown or a similar clip art picture if the circled one is not available.

---

**Learning Objective:**

The student will be able to **save** to current location.

- **Click the quick “Save” button** to save what you have done so far.
Learning Objective:

The student will be able to insert Bullets

1. Click below the picture
2. Click the Bullets button on the Home tab.
3. Type:
   - Friday, March 9
   - 5:00pm
   - Carco Theatre

Press the ENTER (2) times on your keyboard to move to the next line

Type: You can be a star!
Learning Objective:

The student will be able to format **Heading 1**

The student will be able to change styles by changing **style set and fonts**

1. Highlight the title: "Play Auditions"

2. Click the "**Heading 1**" style in the styles gallery

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

1. Click "Change Styles"

2. Click "Style Set"

3. Click "Manuscript"
Play Auditions

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!
Learning Objective:

The student will be able to **Center**

The student will be able to change **Font Size**

The student will be able to change **Font Style**

---

With the text still highlighted:

1. Click the **Font Size** box arrow
2. Click "36"
3. Click the "Center" button

---

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!
Learning Objective:

The student will be able to **underline** the selected text.

The student will be able to apply **italics** to the selected text.

1. Highlight the text "acting, singing, and dancing".

2. Click the "underline" button to underline the highlighted text.

---

**Play Auditions**

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding auditions for an upcoming play. **Tell your dreams and try out!**
Learning Objective:

The student will be able to **save** to current location.

- Click the quick "**Save**" button to save what you have done so far.

---

**Play Auditions**

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding **acting, singing, and dancing** auditions for an upcoming play. Follow your dreams and try out!

- Friday, March 9
- 5:00pm
- Carco Theatre

You can be a star!
Learning Objective:

The student will be able to change **Font Size**

The student will be able to change **Font Style**

1. **Highlight the bulleted list**
2. **Click the Font Size box arrow**
3. **Click “14”**

With the text still highlighted:

1. **Click the font style box arrow**
2. **Click “Batik Regular”**
Learning Objective:

The student will be able to format **Heading 2**

The student will be able to **Center**

The student will be able to change **Font Size**

1. Highlight the last line (signature line)
2. Click **"Heading 2"**
3. Click the **"Center"** button

---

With the signature line still highlighted
1. Click the **Font Size** box arrow
2. Click **"28"**

---

Review View
Add-Ins
Mailings

---

You can be a star!
Learning Objective:

The student will be able to **Center** and resize an image.

The student will be able to choose a **picture style** for an image.

---

1. Click the image
2. Click the "**Center**" button

---

**Play Auditions**

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

- Friday, March 9
- 5:00pm
- Garco Theatre

You can be a star!
company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

- Friday, March 9
- 5:00pm
- Garco Theatre

You can be a star!

Play Auditions

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

- Friday, March 9
- 5:00pm
- Garco Theatre

You can be a star!
Learning Objective:

The student will be able to **save** to current location

- Click the quick “**Save**” button to save what you have done so far.

Make sure the picture is still selected

1. Click “**Format**” under “**Picture Tools**”

2. Click the “more” box arrow

- Click the “**Perspective Shadow, White**” picture style (7th column, 2nd row)
This is how it should look.

---

Play Auditions

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

- Friday, March 9
- 5:00pm
- Carco Theatre

You can be a star!

Learning Objective:

The student will be able to insert a page border

1. Click "Page Layout"

2. Click the "Page Borders" button
1. Click "Art:" box arrow
2. Click the star picture
3. Click "OK"
Play Auditions

Have you ever wanted to act in front of a live audience? Well now is your chance! The theater company will be holding acting, singing, and dancing auditions for an upcoming play. Follow your dreams and try out!

- Friday, March 9
- 5:00pm
- Caruso Theatre

You can be a star!

Click the quick "Save" button to save one last time.
It's Soccer Time!

Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is **August 5 and 6** at the Kick It Arena.

- Learn aggressive footwork
- Condition for the season
- Pass, kick, and boot it out of here

Call Kick It Camp at 555-3693 for more information
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the Microsoft Word Flyer

Learning Objective:
The student will be able to open and save as a word document

- Open Word

- Click the "Office Button"

- Hover over "Save As"

- Click "Word Document"
- Navigate to your “W: Drive”
  1. Click the “My Documents” drop down arrow
  2. Click the **W: drive** (the one with your login name)

- Click the folder “Word Chapter 1”
  2. Click “Open”
Learning Objective:

The student will be able to enter text on a Word document

1. Type the headline:
   
   It's Soccer Time

2. Press the ENTER key on your keyboard to move to the next line
Type the body:

Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is August 5 and 6 at the Kick it Arena.

Learning Objective:

The student will be able to insert Clip Art.

1. Click the "Insert" tab on the ribbon
2. Click "Clip Art"
Learning Objective:

The student will be able to **save** to current location

- Click the quick “Save” button to save what you have done so far.
Learning Objective:

The student will be able to insert **Bullets**

1. Press **Enter** on your keyboard to move below the picture.
2. Click the **Bullets** button on the Home tab.
3. Type:
   - Learn aggressive footwork
   - Condition for the season
   - Pass, kick, and boot it out of here

Press the **ENTER (2)** times on your keyboard to move to the next line.

2. Type:
   
   Call Kick It Camp at 555-3693 for more information

---

**It's Soccer Time!**

Are you interested in playing soccer? No matter what your skill level is, Kick camp is August 5 and 6 at the Kick it Arena.

- Learn aggressive footwork
- Condition for the season
- Pass, kick, and boot it out of here

---

Call Kick It Camp at 555-3693 for more information
Learning Objective:
The student will be able to format **Heading 1** by changing style set, and **color** and **fonts**.

1. Highlight the title: **It’s Soccer Time!**
2. Click the **“Heading 1”** style in the styles gallery.

---

1. Click **“Change Styles”**
2. Click **“Style Set”**
3. Click **“Word 2007”**
1. Click "Change Styles"

2. Click "Colors"

3. Click "Metro"

It's Soccer Time!
Are you interested in playing soccer? No matter what your skill level is, Kick It Camp camp is August 5 and 6 at the Kick It Arena.
1. Click "Change Styles"
2. Click "Fonts"
3. Click "Foundry"

It's Soccer Time!
Are you interested in playing soccer? No matter what your skill level is, we have something here for you. The camp is August 5 and 6 at the Kick it Arena.
Learning Objective:

The student will be able to **Center**

The student will be able to change **Font Size**

The student will be able to change **Font Style**

With the text still highlighted:

1. Click the **Font Size** box arrow.
2. Click "36".
3. Click the "Center" button.

---

**It’s Soccer Time!**

Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is August 5 and 6 at the Kick it Arena.
Learning Objective:

The student will be able to **save** to current location.

- Click the quick **Save** button to save what you have done so far.

Learning Objective:

The student will be able to **Underline**.

- The student will be able to apply **Bold**.
It's Soccer Time!

Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is August 5 and 6 at the Kick it Arena.

- Learn aggressive footwork
- Condition for the season
- Pass, kick, and boot it out of here

Call Kick It Camp at 555-3693 for more information.
Learning Objective:

The student will be able to change **Font Size**

The student will be able to change **Font Style**

1. Highlight the bulleted list
2. Click the **Font Size** box arrow
3. Click "16"

With the text still highlighted:
1. Click the **font style** box arrow
2. Click "Arial Unicode MS"

---

Are you interested in playing soccer? Do that next level is, **Kick It Camp** is here for you. The camp is at the **Kick it Arena**.

- Learn aggressive footwork
- **Condition for the season**
- Pass, kick, and boot it out of here

Call **Kick It Camp** at 500-5000 for more information.
Learning Objective:

The student will be able to format **Heading 2**

The student will be able to **Center**

The student will be able to change **Font Size**

1. Highlight the last line (signature line)
2. Click "Heading 2"
3. Click the "Center" button

---

With the signature line still highlighted
1. Click the **Font Size** box arrow
2. Click "20"

---

Call Kick It Camp at 555-3693 for more information
This is how it should look.

It's Soccer Time!

Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is August 5 and 6 at the Kick it Arena.

- Learn aggressive footwork
- Condition for the season
- Pass, kick, and boot it out of here

Call Kick It Camp at 555-3693 for more information

Learning Objective:

The student will be able to save to current location

- Click the quick "Save" button to save what you have done so far.

Learning Objective:

The student will be able to Center and resize an image

The student will be able to choose a picture style for an image
It's Soccer Time!

Are you interested in playing soccer? No matter what your level is, Kick It Camp is here for you. The camp is August 5 and 6 at the Kick It Arena.

- Learn aggressive footwork

Call Kick It Camp at 555-3693 for more information
This is how it should look.

It's Soccer Time!
Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is **August 5 and 6** at the Kick It Arena.

- Learn aggressive footwork
- Condition for the season
- Pass, kick, and boot it out of here

Call Kick It Camp at 555-3693 for more information

Make sure the picture is still selected.

1. **Click “Format” under “Picture Tools”**
2. **Click the “more” box arrow**
It's Soccer Time!

Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is **August 5 and 6** at the Kick it Arena.

- Learn aggressive footwork
- Condition for the season
- Pass, kick, and boot it out of here

Call Kick It Camp at 555-3693 for more information.
Learning Objective:
The student will be able to insert a page border.

1. Click "Page Layout".
2. Click the "Page Borders" button.

1. Click "Art:" box arrow.
2. Click the outlined person picture.

• Learn aggregates...
1. Click "Color:" box arrow
2. Click "Light Green"
3. Click "OK"
This is what it should look like when you are finished!

It's Soccer Time!

Are you interested in playing soccer? No matter what your skill level is, Kick It Camp is here for you. The camp is August 5 and 6 at the Kick It Arena.

- Learn aggressive footwork
- Condition for the season
- Pass, kick, and boot it out of here

Call Kick It Camp at 555-3693 for more information

*Click the quick "Save" button to save one last time.*
Instructions: Label the following on the flyer:

Heading 1: AaBbCc

Heading 2: AaBbCc

Clip Art

Page Border

Underline

Bullets

Bold

Center

Renton River Days

Come celebrate the wonderful community of Renton! This week-long festivity is a chance for family and friends to gather for many fun activities. From crafts, theater entertainment, to a fun run this week is sure to be a blast!

- Third week in July
- Liberty and Cedar River Park
- Sponsored by IKEA

Come join the fun!
Renton River Days

Come celebrate the wonderful community of Renton! This week-long festivity is a chance for family and friends to gather for many fun activities. From crafts, theater entertainment, to a fun run this week is sure to be a blast!

Third week in July
Liberty and Cedar River Park
Sponsored by IKEA

Come join the fun!
Microsoft PowerPoint
Creating a Presentation

Learning Objectives:
You will have mastered the tasks in this unit when you can perform the following:
- Open PowerPoint
- Save a presentation
- Save to current location
- Select a presentation theme
- Create a title slide
- Create a title and content slide layout
- Create a title and 2 content slide layout
- Use single- and multi-level bulleted lists
- Change font size
- Insert clip art
- Move clip art
- Resize clip art
- Select slide transitions
- Apply custom animations
- Comply by the 7 x 7 rule
- View a presentation in slide show view

What is PowerPoint?
- Microsoft Office Application
- Graphics presentation program
- Professional-looking presentations
- Slide show presentation

Impressive Additions
- Graphics
  - Picture – from file
  - Clip Art
  - Shapes
- Charts
  - From an Excel file
  - Many different chart formats

What Else is Cool?
- Transitions
  - Movement from slide to slide
- Animations
  - Object movement on the slide
- Sound
  - Use sparingly
  - Not too annoying
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the About Microsoft PowerPoint presentation.

Note: The 7 x 7 rule is used on each slide: a maximum of 7 words per line and a maximum of 7 lines per slide.

Learning Objective:
The student will be able to open and save as a PowerPoint 97-2003 presentation

- Open PowerPoint

- Click the "Office Button"

- Hover over "Save As"

- Click "PowerPoint 97-2003 Presentation"
Navigate to your "W: Drive"

1. Click the "My Documents" drop down arrow

2. Click the W: drive (the one with your login name)

- Click the New Folder button
1. Type: PowerPoint
2. Click "OK"

1. Type: About PowerPoint
2. Click "Save"
Learning Objective:

The student will be able to apply a theme to a presentation.

- Click “Design” on the Ribbon to display the Design tab.

- Click the “Equity” theme.
Learning Objective:

The student will be able to create a **title slide** and enter a **title** and **subtitle** to a slide.

- **Click** the **title** text placeholder, "Click to add title".

- **Type**: Microsoft PowerPoint

**Click to add title**

**Microsoft PowerPoint**

**Click to add subtitle**
Click the **subtitle** text placeholder “Click to add subtitle”

**Type:**  
A Presentation Program
Press the ENTER key on your keyboard to move to the next line.

Type: By Student Name (type your name)
Learning Objective:

The student will be able to change **Font Size**

- Highlight the subtitle

“A Presentation Program”

- Click “Home” on the Ribbon to display the Home tab
• With the text still highlighted

1. Click the Font Size box arrow

2. Click “32”

This is how Slide 1 should look
Learning Objective:

The student will be able to **save** to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:

The student will be able to insert a **new slide**.

The student will be able to create a slide with a **two content** layout.

- Click "New Slide"
• Click the layout "Two Content"

Now there are 2 slides in the presentation
What is PowerPoint?
What is PowerPoint?

- Click to add text

Type:

Microsoft Office Application
Press the **ENTER** key on your keyboard to move to the next line.

**Type:**
- Graphics presentation program
- Professional-looking presentations
- Slide show presentation

**Learning Objective:**

The student will be able to **save** to current location.

- Click the quick "**Save**" button to save what you have done so far.
Learning Objective:

The student will be able to insert a **new slide**.

The student will be able to create a slide with a **title and content** layout.

- **Click** “New Slide”
- **Click** the layout “**Title and Content**”
Now there are 3 slides in the presentation.

In the title placeholder,
- Type: 

Impressive Additions
In the text placeholder,

- **Type:**
  - **Graphics**
- Press **Enter**

---

**Learning Objective:**

The student will be able to **increase list level**

The student will be able to **decrease list level**

---

- **Click the "Increase List Level"** button

---
Type:
- Picture-from file
- Clip Art
- Shapes

Click the "Decrease List Level" button.

Type:
- Charts

Press Enter.
• Click the "Increase List Level" button.

Type:
- From an Excel file
- Many different chart formats

Learning Objective:
The student will be able to save to current location.

Click the quick "Save" button to save what you have done so far.
Learning Objective:

The student will be able to insert a new slide.
The student will be able to create a slide with a title and content layout.

- Click “New Slide”

- Click the layout “Title and Content”
Now there are 4 slides in the presentation.

In the title placeholder,
- Type:

What Else is Cool?
- Click to add text
In the text placeholder,

- Type: Transitions
- Press Enter

Learning Objective:

The student will be able to increase list level

The student will be able to decrease list level

- Click the "Increase List Level" button
**What Else is Cool?**

- Transitions
  - Movement from slide to slide

- Animations

Press **Enter**
Click the "Increase List Level" button.

Type:
- Object movement on the slide
- Press Enter

Click the "Decrease List Level" button.
What Else is Cool?

- Transitions
  - Movement from slide to slide
- Animations
  - Object movement on the slide
- Sound

Type:

- Sound

Press Enter

Click the "Increase List Level" button

Type:

- Use sparingly
- Not too annoying

What Else is Cool?

- Transitions
  - Movement from slide to slide
- Animations
  - Object movement on the slide
- Sound

Use sparingly
Not too annoying
Learning Objective:

The student will be able to save to current location

- Click the quick "Save" button to save what you have done so far.

Learning Objective:

The student will be able to insert Clip Art

- Click the Slide 2 thumbnail in the Slides tab
What is PowerPoint?

- Microsoft Office Application
- Graphics presentation program
- Professional-looking presentations
- Slide show presentation

1. Type `powerpoint` in the “Search for:” box
2. Click “Go”
• Click the clip art shown or a similar clip art picture if the circled one is not available.

This is how slide 2 should look

Notice the 7 x 7 rule is followed

Only 7 lines on the slide and no more than 7 words per line

What is PowerPoint?

• Microsoft Office Application
• Graphics presentation program
• Professional-looking presentations
• Slide show presentation
• **Click the “Close” button** to exit clip art.

• **Click the Slide 4 thumbnail** in the Slides tab.
**Learning Objective:**

The student will be able to **insert** Clip Art

The student will be able to **move** Clip Art

The student will be able to **resize** Clip Art

- **Click** “*Insert*” on the Ribbon

- **Click** the “**Clip Art**” button

1. **Type:** `sound` in the “Search for:” box

2. **Click** “Go”
**Click** the clip art shown or a similar clip art picture if the circled one is not available.

This is where the clip art picture is placed.

The next step is to move it.

What Else is Cool?

- Transitions
- Movement from slide to slide
- Animations
- Object movement
- Sound
- Use sparingly
- Not too annoying
Click, hold down the mouse button, and drag the clip art to the lower corner.

This is where the clip art picture has moved.

The next step is to resize it.

What Else is Cool?
- Transitions
  - Movement from slide to slide
- Animations
  - Object movement on the slide
- Sound
  - Use sparingly
  - Not too annoying
Drag the upper left sizing handle diagonally inward until the clip art is resized as shown.

What Else is Cool?

- Transitions
  - Movement from slide to slide
- Animations
  - Object movement on the slide
- Sound
  - Use sparingly
  - Not too annoying

This is how slide 4 should look

Notice the 7 x 7 rule is followed

Only 7 lines on the slide and no more than 7 words per line
Learning Objective:

The student will be able to **save** to current location.

*Click the **Close** button to exit clip art.*

*Click the quick **Save** button to save what you have done so far.*
• Click the **Slide 1** thumbnail in the Slides tab

**Learning Objective:**

The student will be able to apply slide transitions

• Click "**Animations**" on the Ribbon
- Click "Dissolve" in the transitions gallery.

- Click the Slide 2 thumbnail in the Slides tab.

- Click the "More" button for more transitions.
Click “Wipe Up” in the transitions gallery

Click the **Slide 3** thumbnail in the Slides tab
Learning Objective:

- The student will be able to apply custom animations

- **Click** anywhere on the content placeholder

- **Click** "Custom Animation"

---

**Impressive Additions**

- Graphics
- Picture – from file
- Clip Art
- Shapes
- Charts
- From an Excel file
- Many different chart formats
- Click "Add Effect"

1. Click "Entrance"

2. Click "Diamond"
Click the Slide 4 thumbnail in the Slides tab

Click anywhere on the content placeholder

What Else is Cool?

- Transitions
  - Movement from slide to slide
- Animations
  - Object movement on the slide
- Sound
  - Use sparingly
  - Not too annoying
In the Custom Animations gallery:

1. Click “Add Effect”
   ![Add Effect]

2. Click “Entrance”
   ![Entrance]

3. Click “Diamond”
   ![Diamond]

Select an element of the slide, then click “Add Effect” to add animation.
• Click the "Close" button to exit custom animations.

Learning Objective:

The student will be able to save to current location.

• Click the quick "Save" button to save what you have done so far.
Learning Objective:

The student will be able to view a presentation as a slide show.

- Click the "Slide Show" Ribbon

- Click "From Beginning" in the Start Slide Show section

- Click to display slide number 2
What is PowerPoint?

- Microsoft Office Application
- Graphics presentation program
- Professional-looking presentations
- Slide show presentation

Impressive Additions

- Graphics
  - Picture - from file
  - Clip Art
  - Shapes
Impressive Additions

- Graphics
  - Picture – from file
  - Clip Art
  - Shapes
- Charts
  - From an Excel file
  - Many different chart formats

What Else is Cool?

- Transitions
- Movement from slide to slide
- Animations
- Object movement on the slide
- Sound
  - Use sparingly
  - Not too annoying
Learning Objective:

The student will be able to **save** to current location.

- **Click** the quick “Save” button to save one last time.
Internet Safety
PowerPoint Presentation

Why All the Fuss?
- Internet usage has increased
- Online predators has grown
- More unprofessional websites made
- Hackers are getting creative
- More access to personal finances

Be Careful
- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
- Do not meet unknown people

Check Your Computer
- Do you have an anti-virus program?
- Do you have a spyware program?
- What are your firewall settings?
- Is your network secure?
  - Password protect if networked
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the About Microsoft PowerPoint presentation.

Note: The 7 x 7 rule is used on each slide: a maximum of 7 words per line and a maximum of 7 lines per slide.

Learning Objective:
The student will be able to open and save as a PowerPoint 97-2003 presentation

- Open PowerPoint

- Click the "Office Button"

- Hover over "Save As"

- Click "PowerPoint 97-2003 Presentation"
Navigate to your “W: Drive”

1. Click the “My Documents” drop down arrow
2. Click the W: drive (the one with your login name)

1. Click the folder “PowerPoint”
2. Click “Open”
Learning Objective:

The student will be able to apply a theme to a presentation.

- Click "Design" on the Ribbon to display the Design tab.
Learning Objective:

The student will be able to create a **title slide** and enter a **title** and **subtitle** to a slide.
• Click the **title** text placeholder,
  
  "Click to add title"

• **Type:**
  
  **Internet Safety**

• **Internet Safety**
  
  Click to add subtitle
Click the subtitle text placeholder "Click to add subtitle"

Type:

Online warnings
Press the **ENTER** key on your keyboard to move to the next line.

Type:
By Student Name
(type your name)
Learning Objective:
The student will be able to change **Font Size**

- Highlight the title
  
  "Internet Safety"

- Click "Home" on the Ribbon to display the Home tab
With the text still highlighted

1. Click the **Font Size** box arrow

2. Click “54”

This is how Slide 1 should look
Learning Objective:
The student will be able to **save** to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:
The student will be able to insert a **new slide**.
The student will be able to create a slide with a **title and content** layout.

- Click "New Slide"
• Click the layout "Title and Content"

Now there are 2 slides in the presentation
Why All the Fuss?

Why All the Fuss?

- Click to add text
Why All the Fuss?

- Internet usage has increased
Type:
- Online predators has grown
- More unprofessional websites made
- Hackers are getting creative
- More access to personal finances

Learning Objective:

The student will be able to save to current location.

Click the quick “Save” button to save what you have done so far.
Learning Objective:

The student will be able to insert a new slide.

The student will be able to create a slide with a two content layout.

- **Click “New Slide”**

- **Click the layout**
  
  "Two Content"
Now there are 3 slides in the presentation.

In the **title** placeholder,
- Type:

  **Be Careful**
Click the left text placeholder

Be Careful

- Click to add text

Be Careful

- Do not give personal information
- Click to add text

In the text placeholder,

- Type:
  - Do not give personal information

- Press Enter
Learning Objective:

The student will be able to **increase list level**

The student will be able to **decrease list level**

- Click the "Increase List Level" button

- Type: Pictures

- Press Enter

Be Careful

- Do not give personal information
- Pictures [Enter]

- Click to add text
Be Careful

- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
- Do not meet unknown people
Learning Objective:

The student will be able to save to current location.

- Click the quick “Save” button to save what you have done so far.

Learning Objective:

- The student will be able to insert a new slide.
- The student will be able to create a slide with a title and content layout.

- Click “New Slide”
Click the layout "Title and Content"

Now there are 4 slides in the presentation.
Check Your Computer

- Do you have an anti-virus program? Enter
- Do you have a spyware program? Enter
- What are your firewall settings? Enter
- Is your network secure? Enter

Press Enter

In the title placeholder,
- Type:

Check Your Computer

In the text placeholder,
- Type:
  - Do you have an anti-virus program
  - Do you have a spyware program
  - What are your firewall settings?
  - Is your network secure?
- Press Enter
Learning Objective:

The student will be able to **increase list level**.

- Click the "Increase List Level" button.

---

- Type:
  - Password protect if networked.

---

**Check Your Computer**

- Do you have an anti-virus program?
- Do you have a spyware program?
- What are your firewall settings?
- Is your network secure?
  - Password protect if networked.
Learning Objective:

The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:

The student will be able to insert Clip Art.

The student will be able to move Clip Art.

The student will be able to resize Clip Art.

- Click the Slide 3 thumbnail in the Slides tab.
• Click the "Clip Art" button in the content placeholder.

1. Type: **house**

   in the "Search for:" box.

2. Click "Go"
- Click the clip art shown or a similar clip art picture if the circled one is not available.

This is where the clip art picture is placed.

The next step is to resize it.

Be Careful

- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
- Do not meet unknown people
Dr ag the upper left sizing handle diagonally outward until the clip art is resized as shown.

Be Careful

- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
- Do not meet unknown people

This is where the clip art picture is placed.

The next step is to move it.

Be Careful

- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
- Do not meet unknown people
Click, hold down the mouse button, and drag the clip art up.

Be Careful

- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
- Do not meet unknown people

This is how slide 3 should look.

Notice the 7 x 7 rule is followed.

Be Careful

- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
- Do not meet unknown people

Only 7 lines on the slide and no more than 7 words per line.
• Click the "Close" button to exit clip art.

• Click the Slide 4 thumbnail in the Slides tab.
Learning Objective:

The student will be able to insert Clip Art

The student will be able to move Clip Art

The student will be able to resize Clip Art

- Click "Insert" on the Ribbon

- Click the "Clip Art" button
1 Type: **virus**

In the “Search for:” box

2 Click “Go”

- Click the clip art shown or a similar clip art picture if the circled one is not available.
This is where the clip art picture is placed.

The next step is to move it.

Check Your Computer

- Do you have an anti-virus program?
- Do you have a spyware program?
- What are your firewall settings?
- Is your network secure?
  - Password protect if networked

Click, hold down the mouse button, and drag the clip art down and to the right.

Check Your Computer

- Do you have an anti-virus program?
- Do you have a spyware program?
- What are your firewall settings?
- Is your network secure?
  - Password protect if networked
This is where the clip art picture is placed.

The next step is to resize it.

Check Your Computer

- Do you have an anti-virus program?
- Do you have a spyware program?
- What are your firewall settings?
- Is your network secure?
  - Password protect if networked

Drag the upper left sizing handle diagonally outward until the clip art is resized as shown.
This is how slide 4 should look

Notice the 7 x 7 rule is followed

No more than 7 lines on the slide and no more than 7 words per line

Check Your Computer

- Do you have an anti-virus program?
- Do you have a spyware program?
- What are your firewall settings?
- Is your network secure?
  - Password protect if networked

* Click the "Close" button to exit clip art
Learning Objective:

The student will be able to **save** to current location.

- **Click** the quick "**Save**" button to save what you have done so far.

- **Click** the Slide 1 thumbnail in the Slides tab.
Learning Objective:

The student will be able to apply slide transitions

- Click “Animations” on the Ribbon

- Click “Fade Smoothly” in the transitions gallery
- Click the Slide 2 thumbnail in the Slides tab

- Click the "More" button for more transitions
Learning Objective:
- The student will be able to apply custom animations

- Click the Slide 3 thumbnail in the Slides tab
• Click anywhere on the content placeholder

Be Careful

• Do not give personal information
  ▪ Pictures
  ▪ Full name
  ▪ Where you live
  ▪ Where you go to school
• Do not meet unknown people

• Click “Custom Animation”

• Click “Add Effect”
In the Custom Animations gallery:

1. Click “Entrance”

2. Click “Box”

- Click the Slide 4 thumbnail in the Slides tab
Check Your Computer

- Do you have an anti-virus program?
- Do you have a spyware program?
- What are your firewall settings?
- Is your network secure?
  - Password protect if networked

In the Custom Animations gallery

- Click “Add Effect”

- Click anywhere on the content placeholder
In the Custom Animations gallery:

1. Click “Entrance”

2. Click “Fly In”

Click the “Close” button to exit custom animations.
**Learning Objective:**

The student will be able to **save** to current location.

- Click the quick “**Save**” button to save what you have done so far.

---

**Learning Objective:**

The student will be able to view a presentation as a **slide show**.

- Click the “**Slide Show**” Ribbon

---

- Click “**From Beginning**” in the Start Slide Show section.
Internet Safety

Online warnings
By Student Name

Why All the Fuss?

- Internet usage has increased
- Online predators has grown
- More unprofessional websites made
- Hackers are getting creative
- More access to personal finances

Be Careful
- Keep clicking until slide 4 is displayed

**Be Careful**

- Do not give personal information
  - Pictures
  - Full name
  - Where you live
  - Where you go to school
  - Do not meet unknown people

- Click to display text

**Check Your Computer**

- Do you have an anti-virus program?
Learning Objective:

The student will be able to save to current location.

Click the quick "Save" button to save one last time.
Make the Most of it!

Getting involved at school
By Student Name

The Basics
- Show up when you are not sick
- Be on time
- Stay on task
- Do your homework
- Try your hardest
- Ask questions

Extra Curricular Activities
- Join a club or two
  - Examples include:
    - FBLA
    - Environmental Club
    - International Club
- Participate in sports
- Mentor other students

Why Should You Try?
- Graduate from high school
- Employability skills
- Further your education
  - College
  - Apprenticeship
  - University
- Network with people
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the About Microsoft PowerPoint presentation.

Note: The 7 x 7 rule is used on each slide: a maximum of 7 words per line and a maximum of 7 lines per slide.

Learning Objective:
The student will be able to open and save as a PowerPoint 97-2003 presentation

- Open PowerPoint

- Click the "Office Button"

- Hover over "Save As"

- Click "PowerPoint 97-2003 Presentation"
Navigate to your "W: Drive"

1. Click the "My Documents" drop down arrow

2. Click the W: drive (the one with your login name)

1. Click the folder "PowerPoint"

2. Click "Open"
Learning Objective:

The student will be able to apply a theme to a presentation.

- Click “Design” on the Ribbon to display the Design tab.
Learning Objective:

The student will be able to create a **title slide** and enter a **title** and **subtitle** to a slide.
- Click the **title** text placeholder, “Click to add title”

- **Type:**

```
Make the Most of it!
```

```
Make the Most of it!
```

```
Click to add subtitle
```

```
Click to add subtitle
```
Click the subtitle text placeholder "Click to add subtitle"

Make the Most of it!

Click to add subtitle

Make the Most of it!

Getting involved at school
Press the **ENTER** key on your keyboard to move to the next line.

Type:  
**By Student Name**  
(type your name)
**Learning Objective:**

The student will be able to change **Font Size**

<table>
<thead>
<tr>
<th>Highlight the subtitle</th>
<th>Make the Most of it!</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Getting involved at school&quot;</td>
<td>Getting involved at school</td>
</tr>
<tr>
<td>By Student Name</td>
<td></td>
</tr>
</tbody>
</table>

- Click "Home" on the Ribbon to display the Home tab
• With the text still highlighted

1. Click the **Font Size** box arrow

2. Click “28”

This is how Slide 1 should look

Make the Most of it!

Getting involved at school

By Student Name
Learning Objective:

The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:

The student will be able to insert a new slide.

The student will be able to create a slide with a title and content layout.

- Click "New Slide"
Click the layout "Title and Content"

Now there are 2 slides in the presentation
Click the title placeholder

"Click to add title"

• Click to add text

Type:

The Basics

• Click to add text
The Basics

- Show up when you are not sick
Press the **ENTER** key on your keyboard to move to the next line.

**Type:**
- Be on time
- Stay on task
- Do your homework
- Try your hardest
- Ask questions

---

**The Basics**
- Show up when you are not sick
- Be on time
- Stay on task
- Do your homework
- Try your hardest
- Ask questions

---

**Learning Objective:**

The student will be able to **save** to current location.

---

Click the quick **“Save”** button to save what you have done so far.
Learning Objective:

The student will be able to insert a new slide

The student will be able to create a slide with a two content layout

- Click "New Slide"

- Click the layout
  "Two Content"
Now there are 3 slides in the presentation

In the title placeholder,
- Type:
  Extra Curricular Activities
Click the right text placeholder

Extra Curricular Activities

- Click to add text
- Click to add text

- Join a club or two

Press Enter
Learning Objective:

The student will be able to *increase list level*.

The student will be able to *decrease list level*.

- Click the "Increase List Level" button.

- Type:
  - Examples include:
  - Press Enter.

Extra Curricular Activities

- Click to add text
- Join a club or two
  - Examples include: Enter
Click the "Increase List Level" button.

Type:
- FBLA
- Environmental Club
- International Club

Press Enter.

Click the "Decrease List Level" button.

Extra Curricular Activities
- Click to add text
- Join a club or two
  - Examples include:
    - FBLA
    - Environmental Club
    - International Club

Extra Curricular Activities
Learning Objective:

The student will be able to save to current location.

Click the quick "Save" button to save what you have done so far.
Learning Objective:

The student will be able to insert a **new slide**.
The student will be able to create a slide with a **title and content** layout.

- **Click “New Slide”**
- **Click the layout “Title and Content”**
Now there are 4 slides in the presentation.

In the title placeholder, type:

Why Should You Try?
In the text placeholder,
- Type:
  - Graduate from high school
  - Employability skills
  - Further your education
- Press Enter

**Learning Objective:**

The student will be able to **increase list level**

The student will be able to **decrease list level**

- Click the "Increase List Level" button
Why Should You Try?

- Graduate from high school
- Employability skills
- Further your education
  - College
  - Apprenticeship
  - University

Press Enter

Click the "Decrease List Level" button

Type:

- Network with people
Learning Objective:
The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:
The student will be able to insert Clip Art.
The student will be able to move Clip Art.
The student will be able to resize Clip Art.

- Click the Slide 3 thumbnail in the Slides tab.
Extra Curricular Activities

- Click to add text
- Join a club or two
  - Examples include:
    - FBLA
    - Environmental Club
    - International Club
- Participate in sports
- Mentor other students

1. Type: **sports** in the “Search for:” box
2. Click “Go”
Click the clip art shown or a similar clip art picture if the circled one is not available.

This is where the clip art picture is placed.

The next step is to resize it.

Extra Curricular Activities

- Join a club or two
- Examples include:
  - FBLA
  - Environmental Club
  - International Club
- Participate in sports
- Mentor other students
Drag the upper left sizing handle diagonally outward until the clip art is resized as shown.

This is where the clip art picture is placed.

The next step is to move it.

Extra Curricular Activities

- Join a club or two
  - Examples include:
    - FBLA
    - Environmental Club
    - International Club
- Participate in sports
- Mentor other students
Click, hold down the mouse button, and drag the clip art up and to the right.

Extra Curricular Activities

- Join a club or two
  - Examples include:
    - FBLA
    - Environmental Club
    - International Club
- Participate in sports
- Mentor other students

This is how slide 3 should look.

Notice the 7 x 7 rule is followed.

Only 7 lines on the slide and no more than 7 words per line.
- Click the "Close" button to exit clip art.

- Click the Slide 4 thumbnail in the Slides tab.
Learning Objective:

The student will be able to insert **Clip Art**

The student will be able to **move** Clip Art

The student will be able to **resize** Clip Art

- Click "**Insert**" on the Ribbon

- Click the "**Clip Art**" button
1. Type: **education**
   in the “Search for:” box

2. Click “Go”

- Click the clip art shown or a similar clip art picture if the circled one is not available.
This is where the clip art picture is placed.

The next step is to resize it.

Why Should You Try?
- Graduate from high school
- Employability skills
- Further your education
  - College
  - Apprenticeship
  - University
- Network with people

Drag the lower right sizing handle diagonally outward until the clip art is resized as shown.
This is where the clip art picture is placed.

The next step is to move it.

- Click, hold down the mouse button, and drag the clip art up and to the right

**Why Should You Try?**

- Graduate from high school
- Employability skills
- Further your education
  - College
  - Apprenticeship
  - University
- Network with people
This is how slide 4 should look

**Notice the 7 x 7 rule is followed**

Only 7 lines on the slide and no more than 7 words per line

---

**Why Should You Try?**

- Graduate from high school
- Employability skills
- Further your education
  - College
  - Apprenticeship
  - University
- Network with people

---

*Click the “Close” button to exit clip art*
Learning Objective:

The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

- Click the Slide 1 thumbnail in the Slides tab.

Click to add notes
Learning Objective:

The student will be able to apply slide transitions

- Click "Animations" on the Ribbon
- Click the "More" button for more transitions
• Click "Shape Plus" in the transitions gallery

Click the **Slide 2** thumbnail in the Slides tab
- Click the "More" button for more transitions

- Click "Wedge" in the transitions gallery
Learning Objective:
The student will be able to apply custom animations.

- Click anywhere on the content placeholder

- Click "Custom Animation"

The Basics
- Show up when you are not sick
- Be on time
- Stay on task
- Do your homework
- Try your hardest
- Ask questions
Click "Add Effect"

In the Custom Animations gallery:
1. Click "Entrance"
2. Click "More Effects..."

Select an element of the slide, then click "Add Effect" to add animation.
1. Click "Peek In"

2. Click "OK"

- Click the Slide 4 thumbnail in the Slides tab
Why Should You Try?

- Graduate from high school
- Employability skills
- Further your education
  - College
  - Apprenticeship
  - University
- Network with people

In the Custom Animations gallery

- Click "Add Effect"
In the Custom Animations gallery:

1. Click “Entrance”

2. Click “More Effects…”

Click “Strips”

2. Click “OK”
Click the "Close" button to exit custom animations.

Learning Objective:

The student will be able to save to current location.

Click the quick "Save" button to save what you have done so far.
Learning Objective:
The student will be able to view a presentation as a **slide show**.

- Click the "Slide Show" Ribbon

- Click "From Beginning" in the Start Slide Show section

- Click to display slide 2
- Click to display the text

---

- Keep clicking until slide 3 is displayed

---

- Click to display slide 4

---

The Basics

- Show up when you are not sick

---

Extra Curricular Activities

- Join a club or two
  - Examples include:
    - FBLA
    - Environmental Club
    - International Club
- Participate in sports
- Mentor other students
Why Should You Try?

- Graduate from high school

Click to end the slide show
Learning Objective:

The student will be able to save to current location.

- Click the quick "Save" button to save one last time.
Dress for Success
PowerPoint Presentation

**Male Professional Dress**
- Slacks with collared shirt
- Tie (if not wearing blazer)
- Dress shoes
  - No tennis shoes
  - Belt and dress socks

**Female Professional Dress**
- Slacks, skirt, or dress
- Matching blouse or sweater
- Dress shoes
  - No tennis shoes
  - Nylons or dress socks

**Clothing NOT Allowed**
- Denim
- Shorts
- Clothing with tears
- T-shirts/tank tops
- Hats
- Undergarments showing
Directions:
Follow the bulleted instructions and look at the corresponding pictures to create the About Microsoft PowerPoint presentation.

Note: The 7 x 7 rule is used on each slide: a maximum of 7 words per line and a maximum of 7 lines per slide.

Learning Objective:
The student will be able to open and save as a PowerPoint 97-2003 presentation

- Open PowerPoint

- Click the "Office Button"

- Hover over "Save As"

- Click "PowerPoint 97-2003 Presentation"
• Navigate to your “W: Drive”

1. Click the “My Documents” drop down arrow

2. Click the W: drive (the one with your login name)

1. Click the folder “PowerPoint”

2. Click “Open”
Learning Objective:

The student will be able to apply a **theme** to a presentation.

- Click "**Design**" on the Ribbon to display the Design tab.
Learning Objective:

The student will be able to create a **title slide** and enter a **title** and **subtitle** to a slide.
Click the *title* text placeholder, "Click to add title"

Type:

Dress for Success
• Click the **subtitle** text placeholder “Click to add subtitle”

• **Type:**

  By Student Name

---

DRESS FOR SUCCESS

---

By Student Name
Learning Objective:

The student will be able to change **Font Size**.

- Highlight the title
  
  "Dress for Success"

- Click "Home" on the Ribbon to display the Home tab

---

**Dress for Success**

By Student Name

---

**DRESS FOR SUCCESS**
With the text still highlighted

1. Click the Font Size box arrow

2. Click “54”

This is how Slide 1 should look
Learning Objective:

The student will be able to save to current location.

- Click the quick “Save” button to save what you have done so far.

Learning Objective:

The student will be able to insert a new slide.

The student will be able to create a slide with a two content layout.

- Click “New Slide”
Click the layout "Two Content"

Now there are 2 slides in the presentation
Click the title placeholder

“Click to add title”

Type:

Male Professional Dress

Click to add title
<table>
<thead>
<tr>
<th>Type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Tie (if not wearing blazer)</td>
</tr>
<tr>
<td>· Dress shoes</td>
</tr>
</tbody>
</table>

**Male Professional Dress**

- Slacks with collared shirt
- Tie (if not wearing blazer) **Enter**
- Dress shoes **Enter**

**Learning Objective:**

The student will be able to **increase list level**

The student will be able to **decrease list level**

*Click the “Increase List Level” button*
- Type:
  - No tennis shoes
- Press Enter

- Click the "Decrease List Level" button

- Type:
  - Belt and dress socks

Male Professional Dress

- Slacks with collared shirt
- Tie (if not wearing blazer)
- Dress shoes
  - No tennis shoes
- Belt and dress socks
**Learning Objective:**

The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

---

**Learning Objective:**

The student will be able to insert a new slide.

The student will be able to create a slide with a title and content layout.

- Click "New Slide"
Click the layout "Title and Content"

Now there are 3 slides in the presentation
In the **title** placeholder,

- **Type:**

  Female Professional Dress

---

In the text placeholder,

- **Type:**
  - Slacks, skirt, or dress
  - Matching blouse or sweater
  - Dress shoes

- Press **Enter**
Learning Objective:

The student will be able to **increase list level**

The student will be able to **decrease list level**

- Click the "Increase List Level" button

- **Female Professional Dress**
  - Slacks, skirt, or dress
  - Matching blouse or sweater
  - Dress shoes
  - No tennis shoes

Type:
- **No tennis shoes**

Press **Enter**
Click the "Decrease List Level" button.

Type:
- Nylons or dress socks

**Female Professional Dress**
- Slacks, skirt, or dress
- Matching blouse or sweater
- Dress shoes
  - No tennis shoes
- Nylons or dress socks

**Learning Objective:**
The student will be able to save to current location.

Click the quick "Save" button to save what you have done so far.
Learning Objective:

The student will be able to insert a new slide.

The student will be able to create a slide with a two content layout.

- Click "New Slide"

- Click the layout "Two Content"
Now there are 4 slides in the presentation.

In the title placeholder,
- Type:
  - Clothing NOT Allowed

Click to add notes
In the text placeholder,

- Type:
  - Denim
  - Shorts
  - Clothing with tears
  - T-shirts/tank tops
  - Hats
  - Undergarments showing

Click the right text placeholder

Clothing NOT Allowed

- Click to add text
- Click to add text

Clothing NOT Allowed

- Denim
- Shorts
- Clothing with tears
- T-shirts/tank tops
- Hats
- Undergarments showing

Enter
Learning Objective:

The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:

The student will be able to insert Clip Art.

The student will be able to resize Clip Art.

- Click the "Clip Art" button in the content placeholder.

Clothing NOT Allowed

- Click to add text
- Denim
- Shorts
- Clothing with tears
- T-shirts/tank tops
- Hats
- Undergarments showing

Clip Art
1. **Type:** Thumbs down in the "Search for:" box

2. **Click** "Go"

- **Click** the clip art shown or a similar clip art picture if the circled one is not available.
This is where the clip art picture is placed.

The next step is to resize it.

- Drag the upper left sizing handle diagonally outward until the clip art is resized as shown.

**Clothing NOT Allowed**
- Denim
- Shorts
- Clothing with tears
- T-shirts/tank tops
- Hats
- Undergarments showing

**Resizing Handle**
- Denim
- Shorts
- Clothing with tears
- T-shirts/tank tops
- Hats
- Undergarments showing
This is how slide 4 should look

Notice the 7 x 7 rule is followed

Only 7 lines on the slide and no more than 7 words per line

Click the "Close" button to exit clip art
Learning Objective:

The student will be able to insert **Clip Art**

The student will be able to **move** Clip Art

The student will be able to **resize** Clip Art

- Click the **Slide 3** thumbnail in the Slides tab

- Click "**Insert**" on the Ribbon
1. Click the "Clip Art" button

2. Type: suit
   in the "Search for:" box

3. Click "Go"
Click the clip art shown or a similar clip art picture if the circled one is not available.

This is where the clip art picture is placed.

The next step is to move it.
Click, hold down the mouse button, and drag the clip art to the right.

This is where the clip art picture is placed.

The next step is to resize it.
**Drag** the upper left sizing handle diagonally inward until the clip art is resized as shown.

Female Professional Dress

- Slacks, skirt, or dress
- Matching blouse or sweater
- Dress shoes
  - No tennis shoes
- Nylons or dress socks

This is how slide 3 should look

Notice the 7 x 7 rule is followed

No more than 7 lines on the slide and no more than 7 words per line
• Click the "Close" button to exit clip art.

• Click the Slide 2 thumbnail in the Slides tab.

---

**Females**
- Slacks
- Match shoes
- Dress
- No tears
- Nylons

**Male**
- Pants
- Match shoes
- Dress
- No tears
- Pantyhose
Learning Objective:
The student will be able to insert Clip Art.
The student will be able to resize Clip Art.

- Click the "Clip Art" button in the content placeholder.

Male Professional Dress
- Slacks with collared shirt
- Tie (if not wearing blazer)
- Dress shoes
  - No tennis shoes
- Belt and dress socks

1. Type: suit in the "Search for:" box.
2. Click "Go."
Click the clip art shown or a similar clip art picture if the circled one is not available.

This is where the clip art picture is placed.

No moving is necessary.

This is how slide 2 should look.

Notice the 7 x 7 rule is followed.

Only 7 lines on the slide and no more than 7 words per line.

Male Professional Dress

- Slacks with collared shirt
- Tie (if not wearing blazer)
- Dress shoes
  - No tennis shoes
- Belt and dress socks
Learning Objective:

The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

- Click the "Close" button to exit clip art.

- The student will be able to save to current location.
Learning Objective:

The student will be able to apply slide transitions

- Click "Animations" on the Ribbon
• Click the "More" button for more transitions

• Click "Newsflash" in the transitions gallery
• Click the Slide 3 thumbnail in the Slides tab

• Click the "More" button for more transitions
Learning Objective:

The student will be able to apply custom animations.

- Click "Comb Horizontal" in the transitions gallery.

- Click the Slide 2 thumbnail in the Slides tab.
• **Click anywhere on the content placeholder**

**Male Professional Dress**

- Slacks with collared shirt
- Tie (if not wearing blazer)
- Dress shoes
  - No tennis shoes
  - Belt and dress socks

• **Click "Custom Animation"**

• **Click "Add Effect"**

Select an element of the slide, then click "Add Effect" to add animation.
In the Custom Animations gallery:

1. Click “Entrance”
2. Click “More Effects…”

1. Click “Faded Zoom”
2. Click “OK”
- Click the **Slide 4** thumbnail in the Slides tab

- Click anywhere on the content placeholder

---

**Male**

1. Slacks, dress shirt
2. Tie (if morning suit or blazer)
3. Dress
   - No tugs
   - Belt at waist

**Clothing NOT Allowed**

- Denim
- Shorts
- Clothing with tears
- T-shirts/tank tops
- Hats
- Undergarments showing
In the Custom Animations gallery:

1. Click "Add Effect"
2. Click "Entrance"
3. Click "More Effects..."
1. Click "Dissolve In"

2. Click "OK"

- Click the "Close" button to exit custom animations.
Learning Objective:
The student will be able to save to current location.

- Click the quick "Save" button to save what you have done so far.

Learning Objective:
The student will be able to view a presentation as a slide show.

- Click the "Slide Show" Ribbon.

- Click "From Beginning" in the Start Slide Show section.
DRESS FOR SUCCESS

By Student Name

Male Professional Dress

- Slacks with collared shirt
- Tie (if not wearing blazer)
- Dress shoes
  - No tennis shoes
- Belt and dress socks

Keep clicking until slide 3 is displayed
Female Professional Dress

- Slacks, skirt, or dress
- Matching blouse or sweater
- Dress shoes
  - No tennis shoes
- Nylons or dress socks

Clothing NOT Allowed

- Denim
Learning Objective:

The student will be able to **save** to current location.

- **Click** to end the slide show.

- **Click** the quick "**Save**" button to save one last time.
**PowerPoint Labeling Test**

**Instructions:** Label the following on the PowerPoint Presentation.

<table>
<thead>
<tr>
<th>Title slide</th>
<th>Title Slide</th>
<th>Title and Content Slide Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td></td>
<td>Increase list level</td>
</tr>
<tr>
<td>Subtitle</td>
<td></td>
<td>Decrease list level</td>
</tr>
<tr>
<td>Two Content Slide Layout</td>
<td></td>
<td>Clip Art</td>
</tr>
</tbody>
</table>

---

**HOW YOUR CREDIT IS CALCULATED**

- Range: 760 to 620
- 35% Payment history
- 30% Amounts owed
- 15% History length
- 10% New credit
- 10% Credit types

**GIVE YOURSELF SOME CREDIT**

Understanding your credit report

By Student Name

---

**IMPROVE YOUR SCORE**

- Pay bills on time
- Avoid opening many new accounts
  - Open only if you intend to use
- Keep balances low
  - Less than 25% of credit limit
- Review credit report yearly
PowerPoint Test

Slide 1
- **Design Theme**: Opulent
- **Transition**: Dissolve
- **Subtitle**: Size 28 "Understanding your credit report"

Slide 2
- **Slide Layout**: Two Content
- **Clip Art** search for: “credit”
- **Resize** clip art
- **Increase list level**

Slide 3
- **Slide Layout**: Title and Content
- **Increase list level**
- **Decrease list level**
- **Clip Art** search for: “account”
- **Move** clip art
- **Animation**: “Fly In”

---

**HOW YOUR CREDIT IS CALCULATED**
- Range: 760 to 620
  - 35% Payment history
  - 30% Amounts owed
  - 15% History length
  - 10% New credit
  - 10% Credit types

**IMPROVE YOUR SCORE**
- Pay bills on time
- Avoid opening many new accounts
  - Open only if you intend to use
- Keep balances low
  - Less than 25% of credit limit
- Review credit report yearly
Dream Vacation PowerPoint Presentation

Due __________

Plan a **dream vacation**! Create a 6 slide PowerPoint presentation (*with no more than 7 lines and 7 words per line on each slide*). Your presentation must meet the following criteria:

1. Choose a **design theme**
2. **Title slide** has your name and vacation destination
3. Use at least 2 different slide **layouts**
4. Include at least 3 **pictures** (you may use some from the internet).
5. Apply **animation** to 3 slides
6. Apply **transitions** to 3 slides
7. Include a list of the **activities** that you would do while you were at your destination.
8. Include the **culture** of the vacation destination (traditions, clothing, food, etiquettes, etc)
9. Personal vacation pictures can be included. We can scan them and upload them to the server for you to use in your presentation.
10. **NO** busy backgrounds. The audience should be able to read the information without much effort.
11. Presentations need to contain **appropriate material** for school.
12. See the Vacation Assignment Grading on the back for exactly how points are awarded.
### Dream Vacation Rubric

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
<th>Self Evaluation</th>
<th>Teacher Evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 completed slides (minimum)</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 x 7 maximum per slide</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Opening Slide with name/destination</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>At least 2 different slide layouts</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>At least 3 pictures (some from the internet)</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Animation (3 minimum)</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transitions (3 minimum)</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activities</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Culture</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oral Presentation:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Volume level</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eye Contact</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not reading off slides</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Effort</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>47</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER V
SUMMARY, CONCLUSIONS AND RECOMMENDATIONS

Summary

This project was vital for English Language Learners enrolled in Introduction to Information Technology. The purpose of the project was to provide effective differentiated curriculum for two of the most popular computer programs used in other classes and in business for ELL students: Microsoft Word 2007 and Microsoft PowerPoint 2007. The goal of this curriculum was to ensure ELL students the opportunity to learn technology using alternative curriculum that reaches the way ELL students learn best. Current computer curriculum was not achieving this goal.

Through research laid out in chapter II, curriculum was developed based upon what has shown to be the best pedagogical strategies for all students with a focus on ELL students. In addition, input was received from other business educators as the curriculum was being created. Fortunately, the Microsoft Word 2007 curriculum was implemented in the IIT class prior to this project being completed.

Conclusions

The curriculum is predominantly graphics-based as that is how ELL students learn best. Capturing these screen shots and using the corresponding step-by-step directions is a most time consuming activity. There was concern that the students were merely learning how to follow directions and not necessarily learning what the tasks actually perform. The repetitiveness and including the learning objectives before each task was about to be executed helped ease this fear in addition to the performance-based assessment.
How did the ELL students perform using this new Microsoft Word 2007 curriculum? It is important to point out that this curriculum was available during the second semester of the school year. Out of the 45 student who were taking four or more ELL classes, 39 had been in the United States public school system since or before the beginning of the school year. Out of the 39 established ELL student's five students in addition to the six new ELL students used the modified curriculum. Teachers felt the other 34 students could rise to the challenge of following the regular classroom curriculum. Of the 11 students who used the modified curriculum the following was noted:

- Less individual assistance was needed (compared to regular curriculum)
- ELL students were engaged in the assignments
- The end product of each lesson was satisfying (very few corrections)
- Students scored well on the assessment portion proving they understood what each task performed
- Many students wanted to complete the project based assessment just as the other students do at the end of the unit

Recommendations

The curriculum was sent to four other IIT teachers for a trial implementation. All teachers made copies of the lessons in black and white ink while color ink was used in the author’s classroom. The teachers who copied in black and white notice it took the students longer to complete the assignment and caused a little more confusion. Luckily the teachers had a comparison because at least one student in each classroom had the
color copy the author had sent. From that realization color copies were made and tested in the classrooms. Teachers commented that printing in color is imperative because of the computer interface being in color.

Microsoft Word and PowerPoint are only two of the most utilized computer programs used in schools and businesses. Based on feedback from colleagues and advisory committee members, work on this research and curriculum development should continue. In addition Microsoft Excel is another computer program students need to learn in order to be competitive in the job market. It would be ideal for Microsoft Excel 2007 curriculum to be created and implemented in the IIT class.
REFERENCES


http://esl.about.com/library/weekly/aal00499.htm

http://www.cast.org/research/udl/index.html


http://www.siopinstitute.net/pdf/sioppaper.pdf


Lau v. Nichols, 72-6520 (Supreme Court of the United States January 21, 1974).


http://reportcard.ospi.k12.wa.us/Summary.aspx?groupLevel=District&schooolId=1
&reportLevel=State&orgLinkId=1&yrs=2006-07&gradeLevelId=&wasiCategory=&chartType=&year=2006-07